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Display of Zeros and Precision as Displayed 
One of the confounding problems of using any of the financial number formats (accounting, 
currency, and number) is the display of zeros. Recall that the third part of any number format 
code is the code to display zeros. However, the format code only applies when the value in a cell 
is equal to zero, not when the value in a cell appears to be zero, such as when a small value 
rounds off automatically to zero for display. This is especially problematic when using the 
accounting format because cells can be displayed as zeros, positive zeros, or negative zeros as 
shown in Figure 1. 

 

Figure 1 - Zero Display Using the Accounting Format 

Some practitioners have become so frustrated with this problem that they enter hard-coded 
zeros over formulas when this occurs so that zeros display consistently throughout their reports. 
In the process of overwriting their formulas, however, they potentially corrupt their worksheet 
so that it does not recalculate properly in the future. 

There are two easily applied solutions to this problem. The most common solution is to round-
off calculations to the number of displayed decimals. In other words, the values 0.001 or -0.001 
(or smaller) rounded to two decimals would result in a cell value of zero, which would be 
displayed properly when using the accounting format. When a positive or negative zero cell is 
encountered, simply round the contents of the cell to the appropriate number of decimal places 
using the ROUND function. 

The second solution to this problem is to enable global rounding in the affected workbook. When 
global rounding is enabled, all values are rounded to their cell formats. In other words, the values 
0.001 or -0.001 (or smaller) displayed with two decimals would automatically be rounded to a 
cell value of zero, which would be displayed properly when using the accounting format. To 
enable global rounding in a workbook, users of Excel 2010 should click the File tab of the Ribbon, 
Options, Advanced, and in the section labeled When calculating this workbook, check the box 
next to Set precision as displayed and click OK. 
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Regardless of which version of Excel is running, enabling global rounding in a workbook causes 
Excel to display the warning shown in Figure 2. 

 

Figure 2 - Warning Message Displayed When 
Precision as Displayed is Enabled 

Do not be alarmed by the warning. Click OK, and all the cells that contain zeros will now display 
properly. 

Before continuing, an explanation of the warning message is in order. To do that, we must first 
review how Excel makes calculations. In default, Excel rounds off for display but uses the 
underlying data to make calculations. Precision as displayed alters the way that Excel evaluates 
formulas. With precision as displayed enabled, Excel ignores the underlying data and uses the 
data displayed on the screen to make calculations. Hence, when precision as displayed is enabled, 
all calculations will foot and cross-foot properly. In other words, practitioners will not encounter 
the proverbial one cent rounding error that often results in worksheets because the numbers 
displayed on the screen are used to make the calculations. The example in Figure 3 will help in 
explaining precision as displayed.  
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Figure 3 - Rounding Error Corrected by Enabling Precision as Displayed 

  

 

With Precision as 
Displayed Enabled 

With Precision as 
Displayed Disabled 
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Note the one-cent (least significant digit) rounding error in the table at the top of Figure 3. The 
total displayed is $297.71 but should read $297.72. The error occurs because Excel is using the 
underlying data shown in the column displayed on the right to make the calculation. In the 
bottom table, precision as displayed has been enabled. In this case, Excel is using the data 
displayed on the face of the worksheet to make the calculation, and the rounding error 
disappears. 

The Excel Data Model 
All versions of Excel 2013 and newer include the Excel Data Model, a core in-memory OLAP data 
engine. Excel Data Models effectively allow us to link or relate multiple tables of data together 
so that Excel treats them as one. This not only provides great convenience, but it also facilitates 
much faster calculation times and allows for far more data to be included in your analyses, 
particularly PivotTable-based reports.  

4-4-5 Reporting with Related Tables 
As mentioned in the preceding paragraph, we can relate multiple tables together and treat the 
resulting Excel Data Model as a single object. A practical example of this is to relate the Sales 
transaction summary table to the Dates table, thereby avoiding the complexity of building 
VLOOKUP formulas to perform this task. The only requirement is that the Dates table contain a 
record for each date, rather than just the beginning date for each period, as required to use 
VLOOKUP. Similarly, we could use related tables instead of VLOOKUP in transforming coded data 
into an understandable format. 

Begin the PivotTable creation process by selecting Insert, PivotTable to open the Create 
PivotTable dialog box. Enter the name of the first table and make sure to check Add this data to 
the Data Model as shown in Figure 4. Click OK to display the PivotTable placeholder and Field 
List. 
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Figure 4 – Creating a PivotTable Using the Excel Data Model 

When a table is added to the Data Model, the PivotTable Field List can display all fields from all 
tables in a workbook. If the tables are not related, relationships can be created on a common 
field directly from the Field List as shown in Figure 4. With the Excel Data Model, end users can 
create PivotTables from multiple related tables, even if the tables themselves are from multiple 
external data sources. 

Relationships 
In the previous example, establishing relationships between tables was accomplished through a 
link in the PivotTable Field List. A more sophisticated approach to establishing and maintaining 
data relationships between tables is available through the ribbon. Select Data, Relationships to 
access this functionality as shown in Figure 5. 
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Figure 5 – Creating and Maintaining Data Relationships 

Power BI    
Power BI is a separate product from Microsoft.  It is significant enough for mention in this session 
because it works in partnership with Excel and capitalizes on your existing knowledge of Excel.  
Any Excel workbook including specialized reports like PivotTables can be imported directly into 
Power BI.  There are two versions of Power BI for end users.  Power BI Pro $10 per month (cloud-
based) and Power BI Desktop (no charge).   
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Figure 6 – Sample Report Created with Power BI 

Understanding Excel Dates  
Gregorian Calendar 
Excel dates are serial numbers that follow the Gregorian calendar and have a start date basis of 
January 1, 1900.  To see this, change the format on the date to any numeric format or use General 
format and you can easily see the number. This is a significant characteristic because it means 
that business professionals using Excel perform mathematical calculations on dates just as they 
do with any other numbers.  

1904 Date Basis 
Not all information systems followed this rule and as a result some use the start date of January 
1, 1904.  For many years this was a non-issue but the reemergence of Apple products makes this 
an issue again.  Excel can handle these issues with a setting found in Excel Options, Advanced.  
Pictured in Figure 7, this is a workbook-level setting. 
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Figure 7 – Changing Excel for Windows to the 1904 Date System 

Flash Fill 
Flash Fill is a data manipulation feature that allows users to split, combine, or rearrange data 
quickly and easily without using commands or complicated formulas. Whether it's rearranging 
customer contact names, inserting parentheses and hyphens in telephone numbers, or 
separating account numbers and account names in a QuickBooks trial balance, Flash Fill can get 
the job done, as shown in Figure 8. 

 

Figure 8 – Use Flash Fill to Manipulate Data 

There are multiple ways to apply Flash Fill. In default, Excel displays Flash Fill suggestions as you 
work. As shown in Figure 9, a user has modified the first record and has moved to the second 
record. As the user begins modifying the second record, Excel automatically displays a suggested 
flash fill for the column. At that point, the user can press ENTER to accept the suggested flash fill 
or press ESC to cancel the suggested fill. Alternatively, select Data, Flash Fill from the ribbon or 
press CTRL + E to execute Flash Fill from the keyboard. 

To reformat a list of telephone numbers, type one number as it is to appear with parentheses 
and a hyphen, press ENTER, and then press CTRL + E. If Excel is unsure of what is to be done for 
any record, it will skip the record. Move the cursor to a skipped record and "correct" it, and then 
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press CTRL + E to fill similar records. Continue this process until the entire column has been 
updated. 

 

Figure 9 – Excel Automatically Displays a Suggested Flash Fill 

The Accounting Format & Custom Formats 
The Accounting Format 
When asked if they use the accounting format, many accounting professionals respond that they 
do not use it at all. In reality, the accounting format is probably the most frequently used number 
format within the profession. That is because the accounting format is applied whenever the 
currency or comma styles are selected from the Home tab of the Ribbon, as shown on the left in 
Figure 10, or from the Mini-Toolbar, as shown in the same figure on the right. The Mini-Toolbar 
appears whenever a user right-clicks on the worksheet grid. 

 

Figure 10 - Currency and Comma Style Buttons on the Ribbon and Mini-Toolbar 

The currency style applies the accounting format with the dollar sign and two decimal places, 
while the comma style applies the accounting format without the dollar sign. The accounting 
format displays negative numbers within parentheses and ensures that decimal points align – 
perfect for financial reports! 

Single and Double Underlines 
The accounting format affects the way single and double underlines are applied to numbers and 
labels. When using the accounting format, single and double underlines for subtotals, totals, and 
column headings do not span the entire column as do cell borders. The accounting format indents 
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single and double underlines one space from the left and right cell margins. This provides the 
necessary break in underlines across adjacent columns without resorting to the frequent practice 
of inserting narrow faux columns to accomplish the same effect.  

 

Figure 11 - Report Showing the Effect of the Accounting Format on Single 
and Double Underlines 

Figure 11 displays single and double underlines applied to labels and numbers in cells formatted 
with the accounting format. Notice how the single and double underlines do not quite span the 
width of the cells, thereby allowing for breaks in the underlines between adjacent columns. 

 

Figure 12 - Applying Underlines and Double Underlines from the Ribbon 
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 
For single and double underlines to display and print properly for cells 
containing text, the single or double underline formats must be applied after 
applying the accounting format.  For cells that are already underlined when 
the accounting format is applied, simply remove and then reapply the 
underline format. 

 
Custom Formats 
Custom formats can format numbers and text in ways suitable for financial reporting.  For 
example, financial statements may need to be restated and reported in thousands, millions, or 
billions. While many accounting practitioners accomplish this task by dividing their actual data 
by an appropriate divisor, the same result can be accomplished by merely using a custom format 
to display the existing actual data in thousands, millions, or billions, as shown in Figure 13. 

 

Figure 13 - Using Custom Formats to Report in Thousands or Millions 
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To create a custom format to report in thousands, millions, or billions, first format your cells with 
the desired accounting formats – with or without decimals and dollar signs. Next, access the 
Format Cells dialog box with the dialog launcher in the Font group on the Home tab of the Ribbon 
or from the context-sensitive menu. In the Format Cells dialog box, select the Number tab and 
then Custom in the Category box. Modify the format code in the Type box to append commas to 
the positive and negative formats appropriate for your needs. To format the numbers in 
thousands, append one comma; for millions, append two commas; and for billions, append three 
commas. 

 
A format code consists of up to four parts separated by semicolons. Each 
part of the code formats a specific type of numeric or text data within a 
cell. 

 

 

Figure 14 contains the appropriate format codes for using the accounting format displayed in 
thousands, millions, and billions. Note the comma placement identified by the arrows and 
underlines. Also, note that the toolbar buttons for increasing or decreasing the number of 
decimal points displayed works with these custom format codes. 
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Figure 14 - Custom Codes for Displaying the Accounting Format in 
Thousands, Millions, and Billions 

To display and print negative numbers in red, modify any number format to include the tag [Red] 
immediately preceding the negative number format code as shown. In addition to red, the 
following colors may be used in format codes: black, white, green, blue, magenta, yellow, and 
cyan. 

Some accounting professionals prefer to display 0.00 for zeros when using the accounting format. 
This is accomplished easily by modifying the accounting format to include the appropriate zero 
format code. The two custom format codes required, one with dollar signs and the other without, 
are displayed in Figure 15. 

 

Figure 15 - Accounting Format Code Modified to Display 0.00 

 

 



Page 15 of 22 
 

Copyright © 2020, K2 Enterprises, LLC.  
Reproduction or reuse for purposes other than a K2 Enterprises’ training event is prohibited. 

 

Custom Date Formats 
Just like number formats, date formats can be customized. The following table contains the codes 
for building custom date formats. 

To Display Use 
Code 

Months as 1-12 M 
Months as 01-12 Mm 
Months as Jan-Dec Mmm 
Months as January-December Mmmm 
Months as the first letter of the month mmmmm  
Days as 1-31 d  
Days as 01-31 dd  
Days as Sun-Sat ddd  
Days as Sunday-Saturday dddd  
Years as 00-99 yy  
Years as 1900-9999 yyyy  

Table 1 - Custom Date Format Codes 

In the worksheet shown in Figure 16, the column headings are entered as dates. In this case, each 
column heading is the last date of the month formatted to display the three-letter abbreviation 
for the month. 

 

Figure 16 - Using Date Formats to Display Month Headings 

Using dates as column headings allows the report date in the report heading to link easily by 
formula to the latest reported month. This ensures that the report date is always accurate and 
does not require manual update.  
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Cleanup Data with Text to Columns Tool and Power Query 
The data parsing capabilities of Excel are excellent but often you can still end up with “trash” in 
cells.  When faced with text that look like numbers or dates that are not formatted properly, you 
can run the Text to Columns tool to transform your data quickly and easily. This will run the data 
through the standard “car wash” and should clean up your issues. 

As an alternative, you may wish to investigate the power of Excel’s Power Query feature. With 
Power Query, you can easily link or import data from external data sources into Excel. Just as 
important though is the ability to use Power Query to apply transformations to your data. 
Transformations are those “clean-up” processes such as sorting, filtering, splitting columns, 
combining columns, rearranging data, replacing values, etc. that you might need to perform 
repetitively. With Power Query, once you perform your transformations the first time, Excel 
“memorizes” those transformations and automatically performs them every time you update 
your data. 

Using the Camera to Create Report Forms 
That brings us to the Camera tool. The Camera allows users to cut and paste dynamic pictures of 
data ranges which can then be arranged in any layout for display or printing. To use the Camera, 
first add the tool to the QAT. Just click on the drop-down arrow at the right end of the QAT and 
select More Commands. In the Excel Options dialog box, select Commands Not in the Ribbon. 
Scroll down in the list of commands and select the Camera tool. Click Add and then OK to close 
the dialog box as shown in Figure 17. 
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Figure 17 - Adding the Camera to the QAT 

The use of the Camera is similar in operation to cut-and-paste. Highlight the range to copy and 
click the Camera toolbar button. Now, navigate to the worksheet that will serve as your report 
form and click with your mouse on the sheet. A picture of your data snippet will be pasted on the 
worksheet. Click and drag the picture to its proper location. Repeat the process with other data 
snippets to build your report form as shown in Figure 18. 

 



Page 18 of 22 
 

Copyright © 2020, K2 Enterprises, LLC.  
Reproduction or reuse for purposes other than a K2 Enterprises’ training event is prohibited. 

 

 

Figure 18 – Sample Data for Camera Application 

Footnotes on Numbers 
This final tip is only for those of you who are obsessive, although that may include a majority of 
the accounting profession. From time to time, accounting practitioners ask whether it is possible 
to have footnote numbers on numeric data. It is possible, but the process is sufficiently 
convoluted to warrant its use only in the context of templates. In other words, we do not 
necessarily suggest using this process in workbooks created as part of day-to-day tasks and 
activities. 

Attempts to add footnote numbers to numeric data usually end in frustration. That's because the 
footnote number becomes the least significant digit in the number to be footnoted and because 
the superscript formatting is not maintained. Since a footnote number actually alters the numeric 
value in a cell, any calculation on the number is also affected. The solution is to convert the 
numeric data to text. However, that creates another problem – we can't use labels that look like 
numbers in calculations using functions, such as SUM or AVERAGE, that accounting professionals 
use every day. The solution requires numeric data that is calculated accordingly on one 
worksheet (the working sheet) and reported on another (the reporting sheet) as text that looks 
like numeric data, along with the requisite footnote numbers. The footnote numbers will be 
added to the reporting sheet by using a VLOOKUP table. The lookup table will consist of numbers 
cross-referenced to UNICODE superscript numeric characters. 

The Footnotes on Numbers.xlsx file contains the sample data that we will use for this example. 
It contains three worksheets: 1) Numeric Balance Sheet, 2) VLookup Table, and 3) Report Balance 
Sheet. Figure 19 shows the Numeric Balance Sheet. The amount columns contain numeric data. 
The narrow green columns contain the desired footnote number for the data. 
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Figure 19 - Balance Sheet with Numeric Data 

To begin, format the VLookup Table and Report Balance Sheet with Lucida Sans Unicode font. On 
the VLookup Table worksheet, create the VLOOKUP table to return the superscript numbers 
associated with the footnotes desired as shown in Figure 20. 
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Figure 20 - VLOOKUP Table to Return Footnote Numbers 

To create a VLOOKUP table to handle up to fifteen footnotes, do the following. 

1. Create a list of numbers from 1 to 15 in column A. 

2. In column B, adjacent to each cell containing a number, enter the Unicode character(s) 
for the equivalent superscript digit(s). From the Insert tab of the Ribbon, select Symbol. 
Scroll through the list and select the appropriate character. Click Insert and then Close. 

3. Move down one cell and repeat the process until the list is complete. 

 
Note that a UNICODE character set must be used. Make sure to format 
the worksheet holding your VLookup table and final report in Lucida Sans 
Unicode. 

 
4. Create a defined name for the table. Highlight the table and then type in Footnotes in the 

Range Box. 

With the VLOOKUP table created, we need to create a formula to move the data to the report 
worksheet, along with a footnote, if it exists. Our formula will need to use some of the trickery 
discussed earlier to get the result that we desire. Figure 21 shows the results of our efforts. 
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Figure 21 - Report Balance Sheet with Footnotes Displayed on Numbers 

Following is the generalized form of the formula used to move and concatenate the data. The 
sheet reference has been removed for clarity. 

1: =IF(B8="","", 

2: TEXT(B8,"_($*#,##0_);_($*(#,##0);_($*_???") 

3: &IF(ISERROR(VLOOKUP(C8,Footnotes,2))=TRUE,"", 

4: VLOOKUP(C8,Footnotes,2))) 

 

The first line tests whether there is data in a cell of the Numeric Trial Balance. If no data is found, 
the formula returns a null string so that the cell appears blank. If it finds data, the second line 
converts it to text formatted with a modified accounting format. Line three tests whether 
concatenating a nonexistent footnote causes an error. If it causes an error, the formula 
concatenates a null string. If it does not find an error, it concatenates the proper superscript 
character for the footnote from the VLOOKUP table. 
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Ideas 
Ideas in Excel empowers you to understand your data through high-level visual summaries, 
trends, and patterns. Simply click a cell in a data range, and then click the Ideas button on the 
Home tab. Ideas in Excel will analyze your data and return interesting visuals about it in a task 
pane. 

 

Figure 22 – Sample Output from Ideas 

Summary 
Excel currently offers approximately 700 functions, countless keyboard shortcuts, and literally 
hundreds of other features. Yet, most professionals use only a handful of these tools. That is 
largely because of the unawareness of other features available in Excel that can boost efficiency 
and accuracy when working in the application. In this session, you have learned about some of 
the more useful of these tools. But the list is large and we have just seen the tip of the iceberg, 
so commit to a strategy of continual learning so that you can realize the fullest potential of Excel! 
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